
Mendelsim instructions

On-line Help

You can get on-line information about the Mendelsim program in several ways:

(1)  The Getting started exercise.

You will very likely find that the program opens up into this exercise.  It contains about 50 small
screens which will give you a hands-on introduction to the various aspects of the program.  This
is the easiest way of learning about the program.

(2)  The Help menu

The information under this menu largely overlaps with these notes.

(3)  Explain question

Much of the Mendelsim program is based on answering questions which the program poses.
Each question has an 'Explain question' button, which you will need to consult to find exactly
what is expected in answering the question.

(4)  Exercise description

The program is based on exercises.  Each is explained briefly by a window which comes up when
the exercise is first introduced.  You can look at this information again at any time by accessing
the Current exercise description item in the Exercises and questions menu.

You should note that the Mendelsim program can be set up in a number of different ways.  The
version that you are working with may not be exactly as described in these notes.

General program instructions

Animals (or plants)

The essence of what the Mendelsim program does is to take two parents, and make an offspring
from them.  The parents must be in the 'crossing box'.  The offspring appears in the 'offspring
box'.

To make a new offspring, simply drag the old one out of the box.  Provided both parents are
present, a new offspring will automatically appear in the box once it is empty.
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The program allows you to change the animals used as parents.  Drag one or both parents out of
the crossing box. Then replace the parent(s) with whichever individual you wish to cross.  If there
is still an offspring in the box from a previous cross, the program will ask you to remove this
before setting up a new cross.

Cages

Cages are provided in order to keep your offspring in an orderly manner.  You do not have to
use them, but you will lose track of what animals you have if you don't.

There are two sorts of cages.  The first is the Storage cage which appears automatically on the
screen when the program starts.  This cage is intended primarily for storage of individuals
after they have been used in crosses, so that you can go back and re-cross them if necessary.

The second type of cage is one that you create yourself by dragging down from the shelf of
extra cages.  Each time you do this, a dialog box will request a name for the cage.  Try to print
something which is suggestive of the character or characters you are scoring.  But don't worry
if you choose an inappropriate name, because you can always change it.  Some versions of the
program will not ask for a cage name, but will assign it automatically when the cage is used.

Put an animal in the cage by dragging it over the cage and releasing the mouse button.  It
should automatically go in.  The appearance of the cage changes to show that there is an
animal inside.  Avoid having two cages close together, which might lead to confusion as to
which cage the animal goes into.

The number on the cage shows how many animals are inside.  You may not need to look into
the cage to see the animals there.  However if you do, then to see into a cage you must first
'Select' it.  Do this by clicking on it or moving it.  You will see that the cage is surrounded by a
rectangle which shows that it is selected.  Now you should be able to access the Look in cage
item of the Cages menu.  Alternatively, you may double-click on the cage to open it, although
you may find that this does not work as easily as opening it from the menu.

Each cage holds a maximum of 100 offspring.  If you fill a cage, you will need to clear it out or
start another.  The maximum number of cages which can exist at any one time is 16, in
addition to the Storage cage.  It is unlikely that you will use all of these, but if you have used
all your cages then you will need to recycle one before you can start another.

If you want to remove an animal to use as a parent, drag it to the EXIT, which is on the right
side of the cage box.  The animal will disappear from the cage, and you should see it appear on
the main screen in the background.  However you can not access it until the cage has been
closed.

Sometimes, in order to find the animal you want, you may have to use the 'scroll bar' and
scroll down the cage.  In this case the exit door will scroll out of view.  However you still just
need to drag the animal to the right side of the cage to remove it.
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Close the cage down from the Cages menu.  You cannot do anything else while the cage is
open.  As an alternative means of closing the cage, you can click on the 'go-away' box, which
is the small box at the top of the cage screen.

Cages can be cleared in several ways.  There are items in the Cages menu which allow you to
empty a cage or to recycle it, and you can do this either for each cage individually or for all
cages together.  There are shortcut methods for individual cages in which you drag them to the
trash (empty) or back onto the shelf (re-cycle).  In all cases you will first have to click on a
dialog box to confirm your action in order to be sure that you are not mistakenly throwing
away cages or animals.

The Cages menu also contains the item Clear animals not in cages.  This action does not
affect animals which are in the parent or offspring boxes.  You may also throw away
individual animals by dragging them to the Trash.

Animals are stored in the cage in the order in which they are put in, going from left to right
and then down the cage.  If an animal is removed from the Storage cage, its spot is left unfilled.
If you shut the cage and open it again you should see the same unfilled spots.  Thus you can
always go back to any animal, which will be where it was originally put.  For cages other than
the Storage cage, however, the remaining animals close up when the cage is opened again.

Changing exercises

As soon as you complete an exercise, a Next exercise button will appear.  Clicking this will
take you to the next exercise in sequence.  Alternatively, you can go to any exercise, or repeat
the current exercise, by using the Choose exercise command from the Exercises and
questions menu.   Simply click on the exercise you wish to try and click the OK button.

When you access the Choose exercise command, you may find that the exercise you are
currently doing is dimmed.  This indicates that you cannot attempt different examples of the
same exercise (however you may still be able to run trials - see below).  You can do another
exercise and then come back to this exercise, but it will be exactly the same exercise as
previously.

In moving between different exercises, the same organism and same character may show up
more than once.  A limited number of characters is available for the simulation, so that if you
attempt many exercises, it is inevitable that previously seen characters will eventually show
up again.  However it is important to note that re-occurrence of the same character does not
imply anything about its mode of inheritance.  The same character may be inherited as a
dominant in one exercise and as a recessive in another.

Trials

The hardest type of genetics exercises is one in which, as in real life, you do not see the
underlying genotypes.  You will usually find that it helps you to think about the exercise if
you can run through an equivalent simulation with the genotypes showing.  'Trials' allows
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you to do this.  For more information about this command, see the section below on 'Menu
items'.

Depending on how the exercise has been set up, genotypes may not be shown initially.
However they will be available from the Genotypes  item in the File menu.  This enables you
to try the exercise in a number of ways.  You may turn them on at the start of the exercise so
that they are visible at all stages.  Alternatively you may start the exercise without seeing
them, and turn them on only when you feel you need to.

To access the Trial  item, you will have to cut short the simulation you are doing.  Only one
simulation may be in progress at a time.

Exercises and questions

Most exercises are based around a set of questions, which appear at the bottom of the menu
of this name.  The questions vary in length and difficulty.  In some cases you will need to get
the correct answer to a question before moving to the next one, but in most cases the program
will just give a mark to the answer you have put in.

Most questions have no effect on the simulation in the background, so that you can continue
with whatever you are doing.  Some questions, however, ask you to click on an individual of a
particular genotype, and in this case you cannot continue with the simulation until the
question is hidden.

It may help, when beginning an exercise, to see what questions you are expected to answer.
Frequently, however, you can only look at the first question.  The others are suppressed until
the first question is completed, although the name may give some clue as to what the question
is about.

Questions must always be marked in order.  However if a question is showing, you can work
on it at any stage, and the work will not be lost when the question is hidden.

Auto offspring

This command may not be available for all exercises.  If available, it enables you to generate
large numbers of offspring automatically.  However a certain amount of preparation is needed
before you can use it.  It works by adding offspring to cages, so you must have set up the
appropriate cages before the command is activated.

Each time you have a pair of parents in the crossing box, this is known as a 'cross'.  The
program keeps track of how many crosses you have set up.  Each time the parents are
changed, the 'cross number' will be automatically incremented.  The number of the 'current
cross' is shown in the Get info command (see below).  You need not be aware of this cross
number, but if you want to use the Auto offspring command, then you must have cages which
contain only offspring for the current cross.
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Each time you add an animal to an empty cage, that cage becomes associated with the current
cross.  However this works only for an empty cage.  Adding animals to a cage which already
contains offspring from a previous cross will not associate that cage with the current cross.

You need two associated cages before the Auto offspring command becomes activated.
Once this has happened, then as soon as you drag an offspring directly from the offspring box
into one of the cages, extra offspring will start to be generated.

Each time an offspring is generated which exactly matches the phenotype of an animal in one
of the cages, the offspring will be added to that cage.  However if no offspring of matching
phenotype is found, then the process stops and the offspring is shown in the offspring box.
At this stage you can add the offspring to one of the cages yourself, or make a new cage and
add the offspring.  After either of these actions the generation of new offspring will
automatically re-start.

The generation of offspring will continue until either the mouse button is pressed or the
number in one of the cages reaches the maximum of 100.  You can re-start the process by
making a new cage for the phenotype of the filled cage.

You may mix any phenotypes you wish in a cage, eg. you might want to mix females and
males which are otherwise of the same phenotype.  However considerable care in putting
offspring into cages must be exercised.  The program searches sequentially through the cages
when adding a new offspring, and if a single example of the same phenotype is found, it will
add the offspring to that cage.  The consequences of putting an individual into the wrong cage
in the early stages of setting up a cross may thus be unpredictable.

Use of names

When you activate the program you may be confronted with a dialog box, asking you to enter
your name.  You will see that the blinking 'cursor' is in the Name box, so that anything you type
comes into this box.

When you have typed in your name, and clicked on the OK button, or pressed Return, you may
be presented with another dialog box showing a 4-digit number the program has assigned to you.
You should write this number down.   The reason for this number is that you will possibly need
to come back to run the program again, and it is easier to remember a 4-digit number than to
remember the exact format in which you typed your name, eg. did you use capitals or lower case,
full name or initials etc.  Now click on the OK button, and you are ready to start the simulation.

Returning to use the program

You should type in your 4-digit number rather than name.  If you are repeating the same
exercises, then you should get exactly the same opening screen as you got last time.  So, when
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they appear, check to see that the animals (or plants) are exactly the same as those you got the
first time.  If they are not, then something has gone wrong, either in the entering of the number or
in the program.  Note that the offspring will not necessarily be the same as those you got last
time, since chance is built into the simulation.

MENU COMMANDS

(1)  File menu

Get info

This command shows summary statistics of the current status of your current simulation.  In
the left-hand column are shown your name.  Then follow statistics on the total number of
animals which have been generated, the number still surviving, and the number currently in
cages.

The right-hand column shows statistics on the current cross.  It shows the cross number,
which is used by the program to keep track of which cross is in progress.  If either parent has
been removed from the crossing box, then the screen will show that no cross is in effect.  Note
that if a parent is removed from the crossing box and put back straight away, the cross
number will not be changed.  However if a cross is repeated with the same pair of parents
after another cross has been set up, the program will give the cross a new number.

The right-hand column also gives information on the names of cages associated with the
current cross.  Before activating the Auto offspring command, you might check this
information to be sure that the correct cages are in place.

Genotypes

Some exercises will allow you to look at genotypes of the organisms on the screen.  If this is
the case, the Genotypes item will be present.  If not, this item will be absent.

When you access this item, you will see a diagram of the offspring you are dealing with,
pointers to a number of characters with single letter notations, and a list of names of
characters with check boxes.  Some of these letters and names will be dimmed.  Only those
which are associated with variable characters in the current simulation will be activated.

The list on the right-hand side specifies which characters you wish to be shown.  Initially all
characters are checked, so that the complete genotype will be shown if you click OK.  You
may, however, wish to concentrate on just one character, in which case you should leave that
character checked and uncheck the others.  Note that once you click on OK, all animals shown
on the screen need to be re-generated, which may take some time.
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You may also change the notation used to describe each character.  The space available on the
screen restricts the notation to a single letter for each character.  However you may nominate
any letter for each of the variable characters.  Each is initially shown in upper case, but can
equivalently be shown in lower case.  The genotype which appears on the screen will be
determined by the dominance.

Colour

If you have problems with colour vision, you may find that the colours chosen for organisms
are not ones which you find easy to distinguish.  All colours may be edited using the Colour
item in the File menu.

The screen which appears when you access this item depends on which organism is currently
involved in the simulation.  If the 'dogs' are being simulated, no colour editing of phenotype is
possible.  The other organisms allow more than one character to be edited.

To edit a colour, click on the patch showing that colour.  This patch will be surrounded by a
rectangle to show that it is selected, and a 'colour picker' dialog box will be shown.  The form
of this colour picker depends on the particular machine you are working on.  While you are
working with the colour picker, the colours shown in the background may not be reliable.  To
nominate a new colour, you need to click on the OK button in the colour picker and also the
OK button in the colour dialog box.

The effect of choosing a new colour may not easily be appreciated until you see organisms on
the screen showing the colour.  Once a new colour has been nominated, all subsequent
exercises until you quit will show the new colour.

The colour of genotypes may also be edited.  Genes on different chromosome will then be
shown in different colours.  Sex-linked genes are shown in green, and non-sex-linked
(autosomal) genes in reddish colours.  The form in which the genotype is written already
contains all the information to show chromosomal information, so that the use of colours for
genotype information is not strictly necessary.  However in some exercises you may see that
the genotype is written in black rather than in colour.  The program does this to indicate that
the linkage relationship of the loci is unknown, ie. they may be linked or unlinked.

(2)  Auto menu

Auto offspring
Auto cage names

These menu items are used to turn on or turn off the relevant item.  If auto-offspring is
checked, for example, then the auto offspring generation process is started by dragging
offspring from the offspring box into a cage.  See the program Help item or run the
introductory exercise for a more detailed account.  Note that these items may not be available
for all exercises
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(3)  Cages menu

Name/rename cage

This item allows you to change the name of a cage at any time.  The item will be dimmed
unless a particular cage is selected by clicking on it.  To rename a cage, click on the cage, which
causes a red selection rectangle to appear around it, go to the menu item, and edit or type the
new cage name, followed by 'return' or clicking OK.

Empty cage
Recycle cage

These two items are also dimmed unless a cage is selected.  The effect of the first is to clear
out the cage but to leave it on the screen at its current position with the name unchanged.  The
effect of the second is to dispose of the contents and return the cage to the spare cages shelf.
Each of these actions must first be confirmed in a dialog box.

Short cuts are available for both of these actions.  In the first case, drag the cage to the trash.
In the second, drag the cage back up to the spare cages shelf.
Empty all cages
Recycle all cages

These commands refer to all cages rather than to a single cage.  They are available at all times
after cages have been created and used.  The commands do not refer to the Storage cage.  This
cage can be individually emptied, but not re-cycled.

Clear animals not in cages

This command disposes of all uncaged animals from the screen except those in the crossing
and offspring boxes.  Individual animals may also be cleared by dragging to the trash.

Look in cage
Shut cage

These items are needed to see the detailed contents of a cage.  See the program Help for more
detailed descriptions.  The first item is dimmed until a cage is selected.  The second is dimmed
at all times, except when a cage is open in which case it is the only item which is activated.

(4)  Exercises and Questions menu

Choose exercise

As indicated in Program help, to start a new exercise, either a repeat of the one you are doing
or a different exercise, use this item.  It will bring up a dialog box in which you may nominate
a different exercise, click OK without nominating a new exercise to start a new version of the
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same one, or press Cancel to go back to where you were.  Some versions of the program may
also have a button which allows you to nominate the organism at this stage.

List of exercises

This item lists details of all the exercises in the current set.  The different columns are as
follows:

G:  Genotypes are shown, either initially or through the Genotypes menu item.

T:  You may run trials of this exercise, using the Trials menu item.

M:  You may have multiple tries of this exercise.

1:  Number of marks for the exercise.

2:  Marks you have obtained.  Accumulates if you try the exercise more than once.

3: Total marks for the exercise, = Number of marks (1) x Number of tries.

Current exercise description

Each exercise has a description which appears automatically when the exercise starts up.  You
may see this description at any time using this item.

Rules for questions

Some rules which apply to the answering of all questions.  You should read through these the
first time you answer questions.

Questions associated with the exercise

These are given at the bottom of the menu following a line separator.  They are always given
in the form such as:

Ex1 Q1 -  Do something

This would be the first question of Exercise 1.  Most questions will have an associated
Explain question button which gives further details about what is expected, and which you
should read before attempting the question.

A Mark me button is present in most questions.  In some cases, this button will not show up
until it is appropriate to have the question marked.  You should always be careful that you have
completed all that you intend to do on a question before pressing this button.

(5)  Trial menu

When you access this item, the simulation you are doing will be stopped, and you will be
given a new simulation, probably involving different characters.  A label will appear on the
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screen under the spare cages to indicate that a trial is in progress.  The Genotypes  item will
appear in the File menu.

When a trial is in progress, there are two other menu changes:
(a)  The items in the Trial  menu change.  Whereas previously there was one item, Trial , now
you will see

New trial
End trial

Use the first of these items to start another trial, and the second item when you have finished
with trials and want to go back to the original exercise.
(b)  The first item in the Exercises and Questions menu, Choose exercise, will be dimmed.
It only becomes accessible again after you access the End trial item.

(6)  Help menu

The information under this menu is essentially the information contained within these notes.
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